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CiscoWorks Windows 2.0(1) Release Note
This document discusses the CiscoWorks Windows 2.0(1) release. It includes information on
CiscoWorks Windows features and other important material. Use this document in conjunction with
theCiscoWorks Windows Getting Started Guide.

It includes the following:

• CiscoWorks Windows 2.0(1) Features

• CiscoWorks Windows IOS Information

• Additional Documentation Information

• CiscoWorks Windows Device Information

• Incremental Installation Information

• Troubleshooting

• CiscoWorks Windows 2.0(1) Caveats

• Cisco Connection Online

CiscoWorks Windows 2.0(1) Features
CiscoWorks Windows has the following features:

• Configuration Builder—An application that enables you to configure the most common features
in the Cisco Internetwork Operating System (IOS). Using this application, you can quickly and
easily create configuration files for multiple routers, hubs, and access servers without knowing
the router command-line language or syntax.

• Health Monitor—A dynamic fault and performance management tool that provides real-time
statistics on device characteristics, interface status, and protocol information.

• Show Commands—An application that provides a simple way to display detailed information,
including system, protocol, and traffic information for Cisco routers without having to enter
complicated command-line language or syntax.
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CiscoWorks Windows IOS Information
• CiscoView—A graphical network management application that provides a physical view of a
Cisco device, its cards, and its ports. Available device data includes SNMP error messages;
system status information; hardware type and software version number; and device, card, and
port status. This information allows you to monitor network performance, quickly access vital
device information, and troubleshoot minor network problems. Additional networking tools can
be started from CiscoView.

• EtherSwitch Device Management—A suite of applications that enable you to configure and
manage EtherSwitch devices.

• Online Help—A help system that provides information about using CiscoView, device-specific
tasks, and finding product information.

CiscoWorks Windows IOS Information
This section contains the latest Cisco IOS software version information at the time of printing.
New devices and further information about Cisco IOS support will be announced following this
release. Refer to the online release notes on Cisco Customer Connection Online (CCO), formerly
called Cisco Information Online (CIO), or on the Cisco Connection Documentation, Enterprise
Series CD, or the Cisco Connection Documentation, CiscoPro Solutions CD, which are both
accessible via CCO and are continually updated.

Note The Cisco Connection Documentation, Enterprise Series CD was formerly called UniverCD
and the Cisco Connection Documentation, CiscoPro Solutions CD was formerly called UniverCD
for CiscoPro.

Configuration Builder devices support Cisco IOS Software Releases 10.0 through 11.0 (3), with the
exception of Access Servers, which require a minimum of Cisco IOS Software Release 10.2.

CiscoView, Show Commands, and Health Monitor devices support Cisco IOS Software Releases
10.0 through 11.1.

Note CiscoView supports the Qualified Logical Link Control (QLLC) feature in Cisco IOS
Software Release 10.3(7) or later and in Cisco IOS Software Release 11.0(2) or later. CiscoView
supports the Synchronous Data Link Control (SDLC) feature in Cisco IOS Software Release 10.2
or later. CiscoView supports the CIP card in Cisco IOS Software Release 10.2 or later.

Additional Documentation Information
The documentation for CiscoWorks Windows 2.0 includes this document, a CD-ROM booklet,
incremental installation instructions, and online help. The primary documentation for CiscoWorks
Windows is the online help. If you have documentation feedback, please forward comments to
cs-ciscoworks@cisco.com .

You can also see the quick reference card for CiscoView and the CiscoWorks Windows
registration/reference card for information on adding device support to CiscoView.
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CiscoWorks Windows Device Information
CiscoWorks Windows Device Information
CiscoView supports the following devices:

• Catalyst switch models 1200, 1600, 1700, 2100, 2800, 3000, and 5000 series.

• Cisco ATM LightStream Switch models LightStream 100 (formerly called the Cisco
HyperSwitch A100) running RTOS version 3.1(1) and LightStream 2020 running 2.1(2) or later.

• Kalpana switch models EtherSwitch Pro16, EPS-500, EPS-1500, EPS2115, and EPS2015.

• Kalpana EPS2015. Kalpana EtherSwitches EPS-500, EPS-2115, and Pro16 are managed by their
CiscoPro equivalents: CPW500, CPW2115, and CPW16 respectively.

Note Refer to the “Switch Firmware” list in the “Workgroup Products” section for correct firmware
version information.

• CiscoPro switch models CPW10-100, CPW16, CPW500, CPW1200, CPW1400, and CPW2115.

• Workgroup Concentrators 1000, 1100, and 1400, and Workgroup FDDI/CDDI Adapters.

• Cisco 4000 series (includes 4000 and 4500).

• Cisco 2501, 2502, 2503, 2505, 2507, 2509, 2510, 2511, 2512, 2513, 2514, 2515, and 2516.

• Cisco 7000 series (includes 7000 and 7010) and Cisco 7500 series (includes 7505, 7507, and
7513).

Note The Cisco 4700 is not supported by CiscoView or Configuration Builder at this time, but
support will be provided in the near future. You can check Cisco’s World Wide Web site
(www.cisco.com ) periodically for download information on the latest device support and upgrades.
The Cisco 7500 series of routers is not supported by this release of Configuration Builder because
of IOS version limitations, but will be supported in a future release of the product.

Configuration Builder, Show Commands, and Health Monitor support the following devices:

• Configuration Builder

— Routers: 2500, 2501, 2502, 2503, 2505, 2507, 2509, 2510, 2511, 2514, 2512, 2515, 4000,
4500

• HealthMonitor and Show Commands:

— CiscoPro switch models CPW 10-100, CPW16, CPW500, CPW 1200, CPW1400, and
CPW2115

— Routers: AccessPro, 2501-15, 4000, 4500, 7000, 7010

— Hub/Router: 2505 and 2507

— Access Servers: 2509, 2510, 2511, and 2512
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Incremental Installation Information
Incremental Installation Information
To get more information about the Partner Initiated Customer Accounts (PICA) program before
accessing CCO for device package files, use the following URL:

http://www.cisco.com/acs/info/pica.html

You can also see the quick reference card for CiscoView and the CiscoWorks Windows
registration/reference card for information on adding device support to CiscoView.

Troubleshooting
If you cannot open a device in CiscoView, you receive a message indicating that the device is
unmanageable. This message indicates one of the following conditions:

• The Simple Network Management Protocol (SNMP) agent is not running in the device. You can
still ping the device from the management station.

• You have entered an incorrect community string in theFile>Open Device window.

• The management station cannot reach or successfully ping the device.

CiscoWorks Windows 2.0(1) Caveats
This section lists notes and restrictions that apply to the CiscoWorks Windows 2.0(1) release.

• Installation Caveats

• General Caveats

Installation Caveats
The installation notes and caveats are described below.

CiscoWorks Windows
• You should shut down all applications prior to CiscoWorks Windows installation. CiscoWorks

Windows installation may replace old Windows dynamic link libraries (DLLs) with newer
versions and may cause active applications to terminate.

• If the Kalpana SwitchVision application is installed on your system, please deinstall the product
before proceeding with the CiscoWorks Windows install.

• If CiscoWorks Windows fails to run immediately after an initial installation, exit and restart
Windows.

• For CiscoWorks Windows on HP OpenView, if you want to add the management information
bases (MIBs) to the database, run theovmibs.batbatch file created by the install process from the
HP OpenView MIBs directory.

• When you run CiscoWorks Windows on SNMPc for the first time, you are prompted to compile
MIB files. Select theYesbutton. If you don’t compile the MIB files, SNMPc may not properly
discover and manage your Cisco devices, and CiscoWorks Windows applications may not
execute properly.
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CiscoWorks Windows 2.0(1) Caveats
• CiscoWorks Windows is a network management product for Cisco Enterprise routers.
CiscoWorks Windows and CiscoVision should not be installed on the same workstation. This
configuration is not currently supported, and results are unpredictable.

• Upon installing CiscoWorks Windows, you may receive the following error message:

Unable to open MIB database. (OV313-PX72).

Perform the following steps for a workaround:

— Select thewin.ini file from your Windows directory.

— Search for the section called [Paradox Engine].

— In this section, add the following line:MaxTables=10.

Hardware Requirements
The hardware requirement for CiscoWorks Windows 2.0 is 35 to 100 MB, depending on the number
of packages installed.

Changing the Device Community String
You can change the default device community string only once, by using theEdit>Node Defaults
command, and you need to save and reload the network map before the new default community
string takes effect. Performing this procedure again has no effect. You can use the following
workaround to change community strings in the future.

Change the community strings for all devices at once, instead of one at a time, with the following
procedure:

Step 1 Select one node.

Step 2 SelectEdit>Edit Object .

Step 3 SelectComm...

Step 4 Change to the appropriate community string.

Step 5 SelectChange in the Edit Node Attributes window.

Step 6 SelectEdit>Copy.

Step 7 SelectMap>Select Nodes.

Step 8 SelectAll Agent Types and Entire Map.

Step 9 SelectEdit>Paste.

Step 10 Make sure only Community and In Map are selected before clicking onOK .

This sets the community string for all selected objects.

For more information, refer to the Castlerock SNMPc release notes. This information is available by
selecting the Notepad icon labeledSNMPc Release Notes in the SNMPc program group.
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CiscoWorks Windows 2.0(1) Caveats
HP OpenView for Windows
• If you receive the following message when you double-click on an icon, exit and restart SNMPc.

Unknown Node name

When SNMPc is started from HP OpenView, you are asked to compile MIBs. SelectYes.
[CSCdi40732]

• If you receive the error message:

WinSNMP Could not runC:CV4NTtrapx.exe [No TRAPs or IPX!]

when you restart CiscoVision or SNMP immediately after exiting a previous session, wait for at
least 20 seconds before you attempt to restart CiscoVision and SNMPc. [CSCdi40713]

Refer to theSNMPc Network Management Reference Guide for more information about running
CiscoVision/SNMPc with HP OpenView.

Path Environment Variables
If you get the following error message,

couldn't execute "xrdb": no such file or directory

this may mean that the missing program (for example, xrdb) is not in your path. Check your path
environment variable. [CSCdi57661]

SNMPc
• The SNMPc 4.1g CD contains theDSKdirectory. UnderDSKyou will see subdirectories named

1 and 2. Do not install SNMPc fromDSK/1/setup.exe.

• Do not do a vendor installation of SNMPc after installing CiscoWorks Windows. If you do, you
will need to reinstall CiscoWorks.

SNMPc Release Notes
Autodiscovery either finds SNMP devices as ping nodes or finds nothing after clearing the discovery
log. Verify that the read community string is correct. Start autodiscovery again to see if the problem
persists. If it does, terminate autodiscovery and restart from the SNMPc Map menu. [CSCdi40648]

Windows NT
• CWW2.0 is not tested with Optivity 5.3/OV on the same system. [CSCdi57009]

• When double-clicking on Device Install to install a bad WG_Adapter package followed by a
good WGConcentrator package, the following error message appears:

Log File for WGAdapter Install
Do you want to carry on with the rest of the setup?

Selectyesand the setup continues, but the error window is not dismissed. [CSCdi57072]
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General Caveats
The general caveats follow. They are divided into six sections:

• Enterprise Network Management Products and applications including CiscoView,
Configuration Builder, Show Commands, and Health Monitor

• Workgroup Products

• Access Products

• High-end Business Products (including the 7000 series, 7500 series, and ATM switches)

• Online Help

Enterprise Network Management Products
General notes and caveats for Enterprise Network Management products are described below.

Colormap Problems
Windows 95 has a known Microsoft colormap problem where some colors are mapped incorrectly
when switching between applications.

Community String Mismatching
When the user enters values for the “read-only,” “write-only,” and “read-writeId” with the Command
Line Interface (CLI) commands, these values must match. A mismatch results in “noSuchName” or
“timeout” errors. To avoid these error conditions, use identical community strings in CiscoView and
corresponding agents.

Dragging Ports
For this release, use the left mouse button to drag a port on Windows. Only certain devices (such as
the CAT1200, CAT1600, CAT5000, CPW16) have defined their ports for dragging across devices.

HP OpenView Discovery Issue
When a switch is configured as two or more domains, HP OpenView discovery may not work
properly and may discover only one of the domains. If this occurs, use CiscoView to manage the
domain directly rather than launching it from the map.

IP Address
The Health Monitor, CiscoView, Show Commands, and Configuration Builder applications
communicate with a device using its primary IP address. If the primary interface is down, these
applications can not locate or attempt to reach the secondary IP address for that device.
[CSCdi31320]

Popup Menu Titles
Popup menu titles are raised; users may mistake them for menu items. [CSCdi53475
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Starting CiscoView on Device Interfaces
If you start CiscoView on an expanded node's interface icon (for example, foo.cisco.com:1), you
won't be able to telnet to that device—telnet thinks it should use port 1. Do not start CiscoView on
device interfaces. [CSCdi56385]

Stripchart and Dials
Stripchart and dials are sometimes not drawn clearly. [CSCdi51621]

TACACS
If you have TACACS or login security enabled on your router, the Show Commands application and
the Configuration Builder Learn and Send features will not function. However, you can send
configuration files generated by Configuration Builder using the standard TFTP transfer methods.
[CSCdi31004]

Windows 95
On Windows 95 there appears to be different coloring shades in Grapher as port stats is reset. You
can refresh or redisplay the window to work around. [CSCdi53523]

Windows NT
Under the Windows NT environment, running too many sessions of the CiscoWorks Windows
applications (Health Monitor, Show Commands, and Configuration Builder) can cause a General
Protection Fault (GPF) in the moduleMFC250.dll. This is a known Microsoft bug that can be
avoided by running fewer sessions of the applications. [CSCdi31282, CSCdi34536]

WinSNMP Limits
The NetPlusWinSNMP.dll allows only nine instances of CiscoView. The tenth one displays an
initialization error message. This limit can be increased by setting nTasks = <desired #> under the
section labeled [Startup]. For example:

[startup]
nTasks=20

CiscoView
This section contains notes and caveats for the CiscoView application.

CiscoView Times Out
In high traffic situations, you may experience timeouts. To increase the timeout period, select
Options>Properties from the CiscoView menu and change the value for the Timeout field.

You should not reduce the physical view polling interval below (retries*timeout), especially if you
experience timeouts; this can exhaust resources on Windows and result in a general error.

Tables Show all Categories
Multiple selections show all categories, whether they apply to a specific group of selections or not.
If the category doesn’t apply, the config table will show “N/A” in the cells. [CSCdi48854]
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Configuration Builder
This section contains notes and caveats for the Configuration Builder application.

Access Server Dialog Boxes
For access server dialog boxes, the cursor will not provide feedback for incorrect data entry in fields,
nor is the field with incorrect data highlighted. Font resizing at various screen resolutions may cause
the incorrect sizing of text or limit the visible selections in pull-down combo-boxes. You can select
invisible combo-box selections by holding down the right mouse button while in the combo-box,
then scrolling up or down. [CSCdi34066]

Access Server Features
For access server features, the Chat Script Manager dialog box may create

expect null/send null lines

in a chat script. If you inadvertently create empty lines under the Expect and Send fields, you receive
error messages about your chat script. Delete and recreate the chat script. [CSCdi34038]

Context-sensitive Help
Selecting a menu item with the mouse and pressing theF1key opens the Configuration Builder Help
Contents main window instead of starting context-sensitive help. However, context-sensitive help is
supported for all Configuration Builder dialog boxes. [CSCdi34304]

Dialog Box Margins
Dialog box margins may not align on some monitor resolutions. [3D-look]

Sending Configuration Files
Configuration Builder is designed for initial configuration and subsequent modifications of routers.
A configuration sent by Configuration Builder may not completely overwrite a manually created or
modified existing configuration. To simplify the configuration process, Configuration Builder
supports the most common configuration options and uses defaults when possible. You are
encouraged to view configurations before sending them to a router to ensure that the generated
configuration commands and defaults meet your expectations.

If you receive a banner command timeout error message when sending a configuration file, remove
the banner command from the configuration file and resend it. If you receive other command timeout
error messages when sending files, select File>Communication Timeouts. In the Communication
Timeouts dialog box, increase the long and short timeout values, and try sending the file again.
[CSCdi20708]

Spreadsheet Control
• If you use theF1 key often while the input focus is within a dialog box, Configuration Builder

spreadsheet controls can lose track of certain pointers. To release memory and refresh the
pointers, log out of Windows and log in again. [CSCdi34671]
CiscoWorks Windows 2.0(1) Release Note  9



CiscoWorks Windows 2.0(1) Caveats
• When you use the keyboard to navigate spreadsheet style controls, you must press the spacebar
twice to modify a checkbox. [CSCdi15204]

• TheEsckey does not close the window when the input focus is in the spreadsheet style controls.
Use the window menu or move the input focus out of the spreadsheet controls to close the
window. [CSCdi15891]

Health Monitor
TheF1 key context-sensitive help feature is not supported for Health Monitor menu items.
Context-sensitive help is supported for all Health Monitor dialog boxes. [CSCdi32448]

Show Commands
Show Commands features are not supported by all device types. However, Show Commands’
unsupported features can still be selected.

If you select an unsupported feature, you see an error message. For example, if you select the show
controllers CxBus feature for a Cisco CPA2509, you see the following error message:

This command is not supported by this IOS image .

[CSCdi30902]

Workgroup Products

Catalyst 2800, Catalyst 2100, EtherSwitch 1200, and EtherSwitch 1400
General notes and caveats for the above Workgroup Products are described below.

• In the front panel display of the Catalyst 2800 and EtherSwitch 1400, the Connect and Disabled
LEDs on FDDI modules do not reflect the appropriate status.

• CPW 1200, CPW 1400, Cat 2100, Cat 2800—In the General Bridge Window, the Last Topology
Change field does not apply when Spanning Tree is disabled.

• CPW1400, Cat2800—Do not attempt to invoke the Monitoring menu for an FDDI port or a
repeater port. There is no monitoring function provided for these ports, although the pull-down
menu is enabled when such ports are selected.

• CPW1400, Cat2800—The Configure Module Windows do not work when more than one module
type is selected. Please select only one module type before opening these windows.

• CPW 1200, CPW 1400, Cat 2100, Cat 2800—The General Bridge window shows the bridge
information for VLAN1 only. Bridge information for other VLANs is not available.

• CPW 1200, CPW 1400, Cat 2100, Cat 2800—The Spanning Tree Protocol Window for switched
ports is available for ports in VLAN1 only. This window does not show valid information for
ports not in VLAN1.

• The WG-Concentrator, CPW10-100, and WG_Adapter do not show version information in the
About CiscoView dialog box. In these cases, the CiscoView About dialog box displays the
package version only. However, the version information is displayed in the “Packages Installed”
list.
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Community String Mismatching
When the user enters values for the “read-only,” “write-only,” and “read-writeId” with the Command
Line Interface (CLI) commands, these values must match. A mismatch results in “noSuchName” or
“timeout” errors. To avoid these error conditions, use identical community strings in CiscoView and
corresponding agents.

Exiting CiscoView Causes Applications to Close
If you are using the CiscoPro 16/Catalyst 3000 and close the CiscoView window, any application
window that was launched from it will automatically close. Remember to close the EtherChannel
and Domain Configuration application windows before you open another CiscoView application or
exit from the CiscoView application. There is no limitation on the number of CiscoView applications
that you can run.

False Error Reported after Setting Parameters
On the CiscoPro (CPW) 16 and Catalyst 3000, when you try to set parameters for the
EtherChannel/Domain application under moderate to high traffic situations, the application
incorrectly displays an error window indicating that the operation was not successful. In reality, the
command was successful, and you should dismiss the error dialog. The application should continue
to function properly.

LightStream 100
The LightStream 100 VCTool has support for virtual circuit management of the LS100 and can be
invoked from the LS100 CiscoView application.

The LightStream 100 VCTool is currently supported for SunOS 4.1.X and HPUX 9.X.

ProStack Power Supply Link Problem
The rear view of the Prostack matrix power supply does not indicate whether the connector link is
up or down (for example, the connector does not come up green if there is a link).

Switch Firmware
The following firmware versions must be used in the switches:

• Catalyst 2100 and 2800—v. 3.63 or higher

• EtherSwitch 1200 and 2800—v. 3.63 or higher

• Grand Junction FastSwitch 2100 and 2800—v. 3.62 or higher

Note The Grand Junction FastSwitch 2100 and 2800 are managed the same as the Catalyst 2100
and 2800 respectively.

• EtherSwitch 10/100—v. 1.38 or higher

• Catalyst 1700—v. 1.38 or higher

• Grand Junction FastSwitch 10/100—v. 1.37 or higher
CiscoWorks Windows 2.0(1) Release Note  11



CiscoWorks Windows 2.0(1) Caveats
Switches
If you configure EtherChannel or Virtual Domains in Kalpana switch models EPS2015RS,
EPS2115RSM, and Pro16 while running version 9.0 firmware with STP active, the map icons
become red and you receive the following error message:

No response from the device

After restarting the system, deactivate STP before you attempt to reconfigure. This problem is fixed
in version 9.1 of the device firmware. [CSCdi41317]

Access Products
Following are general notes and caveats for the Cisco Access family of products.

Card Support for Cisco 4000 and 4500 Series
• npm-4000-fddi-sas(200)

• npm-4000-fddi-das(201)

• npm-4000-1e(202)

• npm-4000-1r(203)

• npm-4000-2s(204)

• npm-4000-2e1(205)

• npm-4000-2e(206)

• npm-4000-2r1(207)

• npm-4000-2r(208)

• npm-4000-4t(209)

FDDI Port Status Functionality
The Cisco 4000 series devices with DAS FDDI ports show status on only the lower one of the two
connectors. The status color is determined from the port’s administrative status (ifAdminStatus) and
operational status (ifOperStatus) values. [CSCdi28566]

Read-Only MIB Variables
The administrative status (ifAdminStatus) value “testing” and the ring speed (dot5RingSpeed)
variable are implemented as “read-only” in all Cisco IOS versions and are not settable through
popup menus on CiscoView Configure Port screens. However, Configure Port tables (of multiple
ports) offer popup menus that will permit attempts to set these variables. Such attempts will result
in “Permission Denied” messages. [CSCdi50635]

Tunnel Interface
A “can’t read ‘port’ : no such variable” message appears at the bottom of the config port dialog when
a tunnel interface is encountered while clicking up through the ports. This message can be ignored.
[CSCdi55765]
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High-end Business Products
General notes and caveats for High-end Business products are described below.

Core Routers Not 100% Viewable
The core routers’ legends do not display at 100% view. Try the following as a workaround:

Step 1 In the SNMPc window, manually add the 7505 router named corenm7505-1.

Step 2 Double-click on the icon to bring up CiscoView.

Step 3 Notice that at 100% view, the Legend bar at the bottom cannot be viewed; it is only shown
at 50% view.

Step 4 The 7000 doesn’t quite fit on a 1024x769 PC display; however, if you remove the toolbar
and system information area, it is okay. [CSCdi50212]

Displayed ATM Connector Type
CiscoView always displays the multimode fiber SC type of ATM connector on AIPs, even when the
media interface is of another type. [CSCdi53420]

FDDI Port Status Functionality
For 7000/7500 series routers running Cisco IOS Release 10.2 or earlier, the displayed status color is
determined from the port’s administrative status (ifAdminStatus) and operational status
(ifOperStatus) values. This status color will be the same on each connector. For devices running
Cisco IOS Release 10.3 or later, the displayed status color is determined from the Port Connect State
(fddimibPORTConnectState) for each connector. The possible values for this status and the
corresponding status colors are listed below:

[CSCdi28566]

High System Availability (HSA)
• On the 7513 and 7507 chassis, when the master rsp (route switch processor) is in use, the console

port changes color on the CiscoView display. However, when a slave rsp is installed, its console
port mirrors that of the master, regardless of whether or not it is in use. [CSCdi49049]

• In the HSA (dual rsp) configuration, invoking the Admin File Systems function gives an error
message caused by a duplicate flash partition name ("slaveslot0") on the router. This error makes
the File Systems functionality unavailable. The user should acknowledge the error message and
close the "File Systems" window. [CSCdi54831]

Status Status color

disabled brown

standby brown

connecting blue

active green
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LightStream 2020 MIB Support
For the LightStream 2020 there is currently no MIB support for the "LNS OK," "LN FLT," "BITS
OK," and "TCS SEL" LEDS on front linecards. These LEDS appear blank. In addition, the "TX"
and "RX" LEDS on front linecards blink too rapidly for SNMP polling purposes, and also appear
blank.

Lightstream 2020 Truncated
When using CiscoView on the PC platform (either standalone, under OVWIN, or under SNMPc
CastleRock) for a LightStream 2020 ATM switch, a 1280x1024 resolution display is required. Any
lower resolution results in truncated output. [CSCdi49654]

Lighstream 2020 Software Releases Supported
LightStream 2020 supports Release 2.1(2) or later.

OIR Support
Hotswap is only supported on devices running Cisco IOS Release 11.0 or later. [CSCdi53447]

Power Supply Display
By default CiscoView displays two power supplies for a 7000 running Cisco IOS Release 10.2
orearlier. With Cisco IOS Release10.3 or later, power supplies are displayed based on
ciscoEnvMonSupplyState values (ENVIRONMENTAL MIB).

Read-Only MIB Variables
The administrative status (ifAdminStatus) value “testing” and the ring speed (dot5RingSpeed)
variable are implemented as “read-only” in all Cisco IOS versions and are not settable through
popup menus on CiscoView Configure Port screens. However, Configure Port tables (of multiple
ports) offer popup menus that permit attempts to set these variables. Such attempts result in
“Permission Denied” messages. [CSCdi50635]

Online Help
Following are general notes and caveats for CiscoWorks Windows online help.

Options Menu
The following information was omitted from the online help information for the Options menu:

Options>Debug records trace information into a file located in $NMSROOT/cvlog
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Cisco Connection Online
Cisco Connection Online (CCO), formerly Cisco Information Online (CIO), is the Cisco Systems
primary, real-time support channel. Maintenance customers and partners can self-register on CCO to
get additional information and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard and value-added service
to Cisco’s customers and business partners. CCO services include product information, software
updates, release notes, technical tips, the Bug Navigator, configuration notes, brochures, description
of service offerings, and download access to public and authorized files.

CCO serves a wide variety of users through two interfaces that are updated and enhanced
simultaneously—a character-based version and a multimedia version that reside on the World Wide
Web (WWW). The character-based CCO supports Zmodem, Kermit, Xmodem, FTP, Internet e-mail,
and fax download options, and is excellent for quick access to information over lower bandwidths. The
WWW version of CCO provides richly formatted documents with photographs, figures, graphics, and
video, as well as hyperlinks to related information.

You can access CCO in the following ways:

• WWW: http://www.cisco.com

• Telnet: cco.cisco.com

• Modem: From North America, 408 526-8070; from Europe, 33 1 64 46 40 82. Use the following
terminal settings: VT100 emulation; databits: 8; parity: none; stop bits: 1; and baud rates up to
14.4 kbps.

For a copy of CCO’s Frequently Asked Questions (FAQ), contactcco-help@cisco.com.  For
additional information, contactcco-team@cisco.com.

Note If you are a network administrator and need personal technical assistance with a Cisco product
that is under warranty or covered by a maintenance contract, contact Cisco’s Technical Assistance
Center (TAC) at 800 553-2447, 408 526-7209, ortac@cisco.com. To obtain general information about
Cisco Systems, Cisco products, or upgrades, contact 800 553-6387, 408 526-7208, or
cs-rep@cisco.com.

This document is to be used in conjunction with theCiscoWorks Windows CD Installation Instructionspublication.
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